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Modeling Transient Compressible Flow

This tutorial is divided into the following sections:
1. Introduction
2. Prerequisites
3. Problem Description
4. Setup and Solution
5. Summary
6. Further Improvements
1. Introduction
In this tutorial, ANSYS Fluent’s density-based implicit solver is used to predict the time-dependent flow through a two-dimensional nozzle. As an initial condition for the transient problem, a steady-state solution is generated to provide the initial values for the mass flow rate at the nozzle exit.
This tutorial demonstrates how to do the following:
· Calculate a steady-state solution (using the density-based implicit solver) as an initial condition for a transient flow prediction.
· Define a transient boundary condition using a user-defined function (UDF).
· Use dynamic mesh adaption for both steady-state and transient flows.
· Calculate a transient solution using the second-order implicit transient formulation and the density-based implicit solver.
· Create an animation of the transient flow using ANSYS Fluent’s transient solution animation feature. 
2. Problem Description
The geometry to be considered in this tutorial is shown in Figure 1: Problem Specification. Flow through a simple nozzle is simulated as a 2D planar model. The nozzle has an inlet height of 0.2 m, and the nozzle contours have a sinusoidal shape that produces a 20% reduction in flow area. Symmetry allows only half of the nozzle to be modeled.
Figure 6.1:  Problem Specification
[image: ]
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3. Setup and Solution
The following sections describe the setup and solution steps for this tutorial:
4.1. Preparation
4.2. Reading and Checking the Mesh
4.3. Specifying Solver and Analysis Type
4.4. Specifying the Models
4.5. Editing the Material Properties
4.6. Setting the Operating Conditions
4.7. Creating the Boundary Conditions
4.8. Setting the Solution Parameters for Steady Flow and Solving
4.9. Enabling Time Dependence and Setting Transient Conditions
4.10. Specifying Solution Parameters for Transient Flow and Solving
4.11. Saving and Postprocessing Time-Dependent Data Sets
3.1. Preparation
To prepare for running this tutorial:
1. Set up a working folder on the computer you will be using.
3. Download the unsteady_compressible_R150.zip link to download the input and solution files.
4. Unzip the unsteady_compressible_R160.zip file you downloaded to your working folder.
The files nozzle.msh and pexit.c can be found in the unsteady_compressible folder created after unzipping the file.
5. Use Fluent Launcher to start the 2D version of ANSYS Fluent.
6. Ensure that the Display Mesh After Reading, Embed Graphics Windows, and Workbench Color Scheme options are enabled.
7. Ensure that Serial is selected under Processing Options.
8. Disable the Double Precision option.
3.2. Reading and Checking the Mesh
1. Read the mesh file nozzle.msh.
File → Read → Mesh...
The mesh for the half of the geometry is displayed in the graphics window.
2. Check the mesh.
 Setup → [image: ]General → Check
ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure that the reported minimum volume is a positive number.
3. Verify that the mesh size is correct.
 Setup → [image: ]General → Scale...
[image: ]
Close the Scale Mesh dialog box.


4. Mirror the mesh across the centerline (Figure 2: 2D Nozzle Mesh Display with Mirroring ).
Results
 
→
 
Graphics
 
→
 
Views...

[image: ]

a. Select symmetry in the Mirror Planes selection list.
b. Click Apply to refresh the display.
c. Close the Views dialog box.
Figure 6.2:  2D Nozzle Mesh Display with Mirroring
[image: ]
3.3. Specifying Solver and Analysis Type
1.	Select the solver settings.
 Setup → [image: ]General
[image: ]
a. Select Density-Based from the Type list in the Solver group box.
The density-based implicit solver is the solver of choice for compressible, transonic flows without significant regions of low-speed flow. In cases with significant low-speed flow regions, the pressurebased solver is preferred. Also, for transient cases with traveling shocks, the density-based explicit solver with explicit time stepping may be the most efficient.
b. Retain the default selection of Steady from the Time list.



Note
You will solve for the steady flow through the nozzle initially. In later steps, you will use these initial results as a starting point for a transient calculation.

2.	For convenience, change the unit of measurement for pressure.
The pressure for this problem is specified in atm, which is not the default unit in ANSYS Fluent. You must redefine the pressure unit as atm.
 Setup → [image: ]General → Units...
[image: ]
a. Select pressure in the Quantities selection list.
Scroll down the list to find pressure.
b. Select atm in the Units selection list.
c. Close the Set Units dialog box.
3.4. Specifying the Models
[image: ]

1.
Enable the energy equation.
Setup
 
→
 
Models
 
→
 
Energy
On

2. Select the k-omega SST turbulence model.
	 Setup → Models → Viscous		Model → SST k-omega
[image: ]
3.5. Editing the Material Properties
1.	Define the settings for air, the default fluid material.
Setup
 
→
 
Materials
 
→
 
air
 
→
 
Create/Edit...


[image: ]
a.	Select ideal-gas from the Density drop-down list in the Properties group box, so that the ideal gas law is used to calculate density.

Note
ANSYS Fluent automatically enables the solution of the energy equation when the ideal gas law is used, in case you did not already enable it manually in the Energy dialog box.

b. Retain the default values for all other properties.
c. Click the Change/Create button to save your change.
d. Close the Create/Edit Materials dialog box.
3.6. Setting the Operating Conditions
1.	Define the operating pressure.
Setup
 
→
 
Boundary Conditions
 
→
 
Operating Conditions...

[image: ]

a. Enter 0 atm for Operating Pressure.
b. Click OK to close the Operating Conditions dialog box.
Since you have set the operating pressure to zero, you will specify the boundary condition inputs for pressure in terms of absolute pressures when you define them in the next step. Boundary condition inputs for pressure should always be relative to the value used for operating pressure.
3.7. Creating the Boundary Conditions
[image: ]
1. Define the boundary conditions for the nozzle inlet (inlet).
[image: ]Setup
 
→
 
Boundary Conditions
 
Edit...


a. Enter 0.9 atm for Gauge Total Pressure.
b. Enter 0.7369 atm for Supersonic/Initial Gauge Pressure.
The inlet static pressure estimate is the mean pressure at the nozzle exit. This value will be used during the solution initialization phase to provide a guess for the nozzle velocity.
c. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list in the Turbulence group box.
d. Enter 1.5% for Turbulent Intensity.
e. Retain the setting of 10 for Turbulent Viscosity Ratio.
f. Click OK to close the Pressure Inlet dialog box.


2. Define the boundary conditions for the nozzle exit (outlet).
Setup
 
→
 
Boundary Conditions>
 
→   
 
Outlet > edit

[image: ]

Enter 0.7369 atm for Gauge Pressure.
a. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list in the Turbulence group box.
b. Enter 1.5% for Backflow Turbulent Intensity.
c. Retain the setting of 10 for Backflow Turbulent Viscosity Ratio.
If substantial backflow occurs at the outlet, you may need to adjust the backflow values to levels close to the actual exit conditions.
d. Click OK to close the Pressure Outlet dialog box.


3.8. Setting the Solution Parameters for Steady Flow and Solving
In this step, you will generate a steady-state flow solution that will be used as an initial condition for the time-dependent solution.
1. Define the solution parameters. Solution → [image: ]Solution Methods
[image: ]
a. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the Spatial Discretization group box.
b. Select Second Order Upwind from the Turbulent Kinetic Energy and Specific Dissipation Rate dropdown lists.
Second-order discretization provides optimum accuracy.
2. Modify the Courant Number. 
 Solution → Solution Controls
[image: ]
a. Enter 50 for the Courant Number.

Note
The default Courant number for the density-based implicit formulation is 5. For relatively simple problems, setting the Courant number to 10, 20, 100, or even higher value may be suitable and produce fast and stable convergence. However, if you encounter convergence difficulties at the startup of the simulation of a properly set up problem, then you should consider setting the Courant number to its default value of 5. As the solution progresses, you can start to gradually increase the Courant number until the final convergence is reached.

	b.	Retain the default values for the Under-Relaxation Factors.












3. Enable the plotting of residuals.
	 Solution → Monitors → Residual	 Edit...
[image: ]
a. Ensure that Plot is enabled in the Options group box.
b. Select none from the Convergence Criterion drop-down list.
c. Click OK to close the Residual Monitors dialog box.
4. Enable the plotting of mass flow rate at the flow exit.
	 Solution → Monitors → Surface	 New...
[image: ]

a. Enable Plot and Write.


Note
When Write is enabled in the Surface Monitor dialog box, the mass flow rate history will be written to a file. If you do not enable the write option, the history information will be lost when you exit ANSYS Fluent.

b. Enter noz_ss.out for File Name.
c. Select Mass Flow Rate in the Report Type drop-down list.
d. Select outlet in the Surfaces selection list.
e. Click OK to close the Surface Monitor dialog box.
5. Save the case file (noz_ss.cas.gz).
File → Write → Case...
6. Initialize the solution.
 Solution → [image: ]Solution Initialization
[image: ]
a. Retain the default selection of Hybrid Initialization from the Initialization Methods group box. b. Click Initialize.
7. Set up gradient adaption for dynamic mesh refinement.
You will enable dynamic adaption so that the solver periodically refines the mesh in the vicinity of the shocks as the iterations progress. The shocks are identified by their large pressure gradients.


Adapt → Gradient...

[image: ]
a. Select Gradient from the Method group box.
The mesh adaption criterion can either be the gradient or the curvature (second gradient). Because strong shocks occur inside the nozzle, the gradient is used as the adaption criterion.
b. Select Scale from the Normalization group box.
Mesh adaption can be controlled by the raw (or standard) value of the gradient, the scaled value (by its average in the domain), or the normalized value (by its maximum in the domain). For dynamic mesh adaption, it is recommended that you use either the scaled or normalized value because the raw values will probably change strongly during the computation, which would necessitate a readjustment of the coarsen and refine thresholds. In this case, the scaled gradient is used.
c. Enable Dynamic in the Dynamic group box.
d. Enter 100 for the Interval.
For steady-state flows, it is sufficient to only seldomly adapt the mesh—in this case an interval of 100 iterations is chosen. For time-dependent flows, a considerably smaller interval must be used.
e. Retain the default selection of Pressure... and Static Pressure from the Gradients of drop-down lists. 
f. 	Enter 0.3 for Coarsen Threshold.
g. Enter 0.7 for Refine Threshold.
As the refined regions of the mesh get larger, the coarsen and refine thresholds should get smaller. A coarsen threshold of 0.3 and a refine threshold of 0.7 result in a “medium” to “strong” mesh refinement in combination with the scaled gradient.
g. Click Apply to store the information.
h. Click the Controls... button to open the Mesh Adaption Controls dialog box.
[image: ]
i. Retain the default selection of fluid in the Zones selection list.
ii. Enter 20000 for Max # of Cells.
To restrict the mesh adaption, the maximum number of cells can be limited. If this limit is violated during the adaption, the coarsen and refine thresholds are adjusted to respect the maximum number of cells. Additional restrictions can be placed on the minimum cell volume, minimum number of cells, and maximum level of refinement.
iii. Click OK to save your settings and close the Mesh Adaption Controls dialog box.
i. Click Close to close the Gradient Adaption dialog box.



8. Start the calculation by requesting 500 iterations.
[image: ]Solution
 
→
 
Run Calculation


a. Enter 500 for Number of Iterations.
b. Click Calculate to start the steady flow simulation.
Figure 6.3:  Mass Flow Rate History
[image: ]


9. Save the case and data files (noz_ss.cas.gz and noz_ss.dat.gz).
File → Write → Case & Data...

Note
When you write the case and data files at the same time, it does not matter whether you specify the file name with a .cas or .dat extension, as both will be saved.

10. Click OK in the Question dialog box to overwrite the existing file.
11. Review a mesh that resulted from the dynamic adaption performed during the computation.
[image: ]Results
 
→
 
Graphics
 
→
 
Mesh
Edit...


a. Ensure that only the Edges option is enabled in the Options group box.
b. Select Feature from the Edge Type list.
c. Ensure that all of the items are selected from the Surfaces selection list.
d. Click Display and close the Mesh Display dialog box.
The mesh after adaption is displayed in the graphics window (Figure 4: 2D Nozzle Mesh after Adaption)


Figure 4:  2D Nozzle Mesh after Adaption
[image: ]
Zoom in using the middle mouse button to view aspects of your mesh.Notice that the cells in the regions of high pressure gradients have been refined.
12. Display the steady flow contours of static pressure (Figure 5: Contours of Static Pressure (Steady Flow)).
	 Results → Graphics → Contours	 Edit...

[image: ]
a. Enable Filled in the Options group box.
b. Click Display and close the Contours dialog box.
Figure 5:  Contours of Static Pressure (Steady Flow)
[image: ]
The steady flow prediction in Figure 5: Contours of Static Pressure (Steady Flow) shows the expected pressure distribution, with low pressure near the nozzle throat.

13. Display the steady-flow velocity vectors (Figure 6:Velocity Vectors Showing Recirculation (Steady Flow)).
	 Results → Graphics → Vectors	 Edit...
[image: ]
a. Enter 50 under Scale.
b. Click Display and close the Vectors dialog box.
The steady flow prediction shows the expected form, with a peak velocity of approximately 300 m/s through the nozzle.
You can zoom in on the wall in the expansion region of the nozzle to view the recirculation of the flow as shown in Figure 6: Velocity Vectors Showing Recirculation (Steady Flow).


Figure 6: Velocity Vectors Showing Recirculation (Steady Flow)
[image: ]





14. Check the mass flux balance.

Important
Although the mass flow rate history indicates that the solution is converged, you should also check the mass flux throughout the domain to ensure that mass is being conserved.
Results
 
→
 
Reports
 
→
 
Fluxes
Edit...

[image: ]

a. Retain the default selection of Mass Flow Rate.
b. Select inlet and outlet in the Boundaries selection list.
c. Click Compute and examine the values displayed in the dialog box.

Important
The net mass imbalance should be a small fraction (for example, 0.1%) of the total flux through the system. The imbalance is displayed in the lower right field under Net Results. If a significant imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and continue iterating.

	d.	Close the Flux Reports dialog box.


3.9. Enabling Time Dependence and Setting Transient Conditions
In this step you will define a transient flow by specifying a transient pressure condition for the nozzle.
1. Enable a time-dependent flow calculation.
	 Setup → General	 Analysis Type → Transient
2. Read the user-defined function (pexit.c), in preparation for defining the transient condition for the nozzle exit.
The pressure at the outlet is defined as a wave-shaped profile, and is described by the following equation:
		(6.1)
where
	=	circular frequency of transient pressure (rad/s)
	=	mean exit pressure (atm)
In this case,  rad/s, and  atm.
A user-defined function (pexit.c) has been written to define the equation (Equation 6.1) required for the pressure profile.

Note
To input the value of Equation 1 in the correct units, the function pexit.c has to be written in SI units.

More details about user-defined functions can be found in the Fluent Customization Manual.
Define → User-Defined → Functions → Interpreted...
[image: ]


a. Enter pexit.c for Source File Name.
If the UDF source file is not in your working directory, then you must enter the entire directory path for Source File Name instead of just entering the file name.
b. Click Interpret.
The user-defined function has already been defined, but it must be compiled within ANSYS Fluent before it can be used in the solver.
c. Close the Interpreted UDFs dialog box.
3. Define the transient boundary conditions at the nozzle exit (outlet).
 Setup → Boundary Conditions → outlet  Edit...
[image: ]
a. Select udf transient_pressure (the user-defined function) from the Gauge Pressure drop-down list.
b. Click OK to close the Pressure Outlet dialog box.



4. Update the gradient adaption parameters for the transient case.
Adapt → Gradient...
a. Enter 10 for Interval in the Dynamic group box.
For the transient case, the mesh adaption will be done every 10 time steps.
b. Enter 0.3 for Coarsen Threshold.
c. Enter 0.7 for Refine Threshold.
The refine and coarsen thresholds have been changed during the steady-state computation to meet the limit of 20000 cells. Therefore, you must reset these parameters to their original values. d. Click Apply to store the values.
	e.	Click Controls... to open the Mesh Adaption Controls dialog box.
i.	Enter 8000 for Min # of Cells.
            ii.	Enter 30000 for Max # of Cells.
You must increase the maximum number of cells to try to avoid readjustment of the coarsen and refine thresholds. Additionally, you must limit the minimum number of cells to 8000, because you should not have a coarse mesh during the computation (the current mesh has approximately 20000 cells).
iii.      Click OK to close the Mesh Adaption Controls dialog box.

	f.	Close the Gradient Adaption dialog box.








3.10. Specifying Solution Parameters for Transient Flow and Solving
1. Modify the plotting of the mass flow rate at the nozzle exit.
Because each time step requires 10 iterations, a smoother plot will be generated by plotting at every time step.
Solution
 
→
 
Monitors
 
→
 
Surface
 
→
 
surf-mon-1
Edit...

[image: ]
a. A. Set window to 3
b. Enter noz_uns.out for File Name.
c. Select Time Step from the X Axis drop-down list.
d. Select Time Step from the Get Data Every drop-down list.
e. Click OK to close the Surface Monitor dialog box.
2. Save the transient solution case file (noz_uns.cas.gz).
File → Write → Case...
3. Modify the plotting of residuals.
 Solution → Monitors → Residual  Edit...
a. Ensure that Plot is enabled in the Options group box.
b. Ensure none is selected from the Convergence Criterion drop-down list.
c. Set the Iterations to Plot to 100.
d. Click OK to close the Residual Monitors dialog box.

4. Define the time step parameters.
The selection of the time step is critical for accurate time-dependent flow predictions. Using a time step of 2.85596 x 10-5 seconds, 100 time steps are required for one pressure cycle. The pressure cycle begins and ends with the initial pressure at the nozzle exit.
[image: ]Solution
 
→
 
Run Calculation


a. Enter 2.85596e-5 s for Time Step Size.
b. Enter 600 for Number of Time Steps.
c. Enter 10 for Max Iterations/Time Step.
d. Click Calculate to start the transient simulation.

Warning
Calculating 600 time steps will require significant CPU resources. 
By requesting 600 time steps, you are asking ANSYS Fluent to compute six pressure cycles. The mass flow rate history is shown in Figure 7: Mass Flow Rate History (Transient Flow).

Figure 7:  Mass Flow Rate History (Transient Flow)
[image: ]
5. Optionally, you can review the effect of dynamic mesh adaption performed during transient flow computation as you did in steady-state flow case.
6. Save the transient case and data files (noz_uns.cas.gz and noz_uns.dat.gz).
File → Write → Case & Data...




3.11. Saving and Postprocessing Time-Dependent Data Sets
At this point, the solution has reached a time-periodic state. To study how the flow changes within a single pressure cycle, you will now continue the solution for 100 more time steps. You will use ANSYS Fluent’s solution animation feature to save contour plots of pressure and Mach number at each time step, and the autosave feature to save case and data files every 10 time steps. After the calculation is complete, you will use the solution animation playback feature to view the animated pressure and Mach number plots over time.
1.	Request the saving of case and data files every 10 time steps.
Solution
 
→
 
Calculation Activities
 
→
 
Autosave (Every Time Steps)

[image: ]
a. Enter 10 for Save Data File Every.
b. Select Each Time for Save Associated Case Files.
c. Retain the default selection of time-step from the Append File Name with drop-down list.
d. Enter noz_anim.gz for File Name.
When ANSYS Fluent saves a file, it will append the time step value to the file name prefix (noz_anim).
The standard extensions (.cas and .dat) will also be appended. By adding the optional extension .gz to the end of the file name, you instruct ANSYS Fluent to save the case and data files in compressed format. This will yield file names of the form noz_anim-1-00640.cas.gz and noz_anim-1-00640.dat.gz, where 00640 is the time step number.
e. Click OK to close the Autosave dialog box.

Tip
If you have constraints on disk space, you can restrict the number of files saved by ANSYS Fluent by enabling the Retain Only the Most Recent Files option and setting the Maximum Number of Data Files to a nonzero number.

2.	Create animation sequences for the nozzle pressure and Mach number contour plots.
[image: ]Solution
 
→
 
Calculation Activities
 
→
 
Solution Animations
Edit...


a. Set Animation Sequences to 2.
b. Enter pressure for the Name of the first sequence and mach-number for the second sequence.
c. Select Time Step from the When drop-down lists for both sequences.
The default value of 1 in the Every integer number entry box instructs ANSYS Fluent to update the animation sequence at every time step.
d. Click the Define... button for pressure to open the associated Animation Sequence dialog box.
[image: ]
i. Select In Memory from the Storage Type group box.
The In Memory option is acceptable for a small 2D case such as this. For larger 2D or 3D cases, saving animation files with either the Metafile or PPM Image option is preferable, to avoid using too much of your machine’s memory.
ii. Enter 4 for Window and click the Set button. iii. Select Contours from the Display Type group box to open the Contours dialog box.
[image: ]
A. Ensure that Filled is enabled in the Options group box.
B. Disable Auto Range.
C. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down lists.
D. Enter 0.25 atm for Min and 1.25 atm for Max.
This will set a fixed range for the contour plot and subsequent animation. E. Click Display and close the Contours dialog box.
Figure 8: Pressure Contours at t=0.017136 s (p. 290) shows the contours of static pressure in the nozzle after 600 time steps.


Figure 8:  Pressure Contours at t=0.017136 s
[image: ]
iv. Click OK to close the Animation Sequence dialog box associated with the pressure sequence.
Note that the Active option is automatically enabled in the Solution Animation dialog box after you have defined the sequence.
e. Click the Define... button for mach-number to open the associated Animation Sequence dialog box.
i. Ensure that In Memory is selected in the Storage Type list.
ii. Enter 5 for Window and click the Set button.
iii. Select Contours in the Display Type group box to open the Contours dialog box. A.	Ensure that Filled is enabled from the Options group box.
B. Disable Auto Range.
C. Select Velocity... and Mach Number from the Contours of drop-down lists.
D. Enter 0.00 for Min and 1.30 for Max.
E. Click Display and close the Contours dialog box.
Figure 9: Mach Number Contours at t=0.017136 s shows the Mach number contours in the nozzle after 600 time steps.
Figure 9:  Mach Number Contours at t=0.017136 s
[image: ]
d.  Click OK to close the Animation Sequence dialog box associated with the mach-number sequence.
f. Click OK to close the Solution Animation dialog box.
3. Continue the calculation by requesting 100 time steps.
By requesting 100 time steps, you will march the solution through an additional 0.0028 seconds, or roughly one pressure cycle.
With the autosave and animation features active (as defined previously), the case and data files will be saved approximately every 0.00028 seconds of the solution time; animation files will be saved every 0.000028 seconds of the solution time.
 Solution → [image: ]    Run Calculation
[image: ]
Enter 100 for Number of Time Steps and click Calculate.
When the calculation finishes, you will have ten pairs of case and data files and there will be 100 pairs of contour plots stored in memory. In the next few steps, you will play back the animation sequences and examine the results at several time steps after reading in pairs of newly saved case and data files.
4. Check the display options to verify that double buffering is enabled.
Double buffering will allow for a smoother transition between the frames of the animations.
	 Results → Animations		Options...
[image: ]
a. Retain the Double Buffering option in the Rendering group box.
b. Enter 4 for Active Window and click the Set button.

Note
Alternatively, you can change the active window using the drop-down list at the top of the graphics window.

	c.	Click Apply and close the Display Options dialog box.
5. Play the animation of the pressure contours.
	 Results → Animations → Solution Animation Playback		Edit...
[image: ]
a. Retain the default selection of pressure in the Sequences selection list.
Ensure that window 4 is visible in the graphics window. If it is not, select it from the drop-down list at the top left of the graphics window.
b. Click the play button (the second from the right in the group of buttons in the Playback group box).
c.  Close the Playback dialog box.
Examples of pressure contours at  s (the 630th time step) and  s (the 670th time step) are shown in Figure 10: Pressure Contours at t=0.017993 s and Figure 11: Pressure Contours at t=0.019135 s.


6. In a similar manner to steps 4. and 5., select the appropriate active window and sequence name for the Mach number contours.
Examples of Mach number contours at  s and  s are shown in Figure 12: Mach Number Contours at t=0.017993 s and Figure 13: Mach Number Contours at t=0.019135 s.


Figure 10:  Pressure Contours at t=0.017993 s
[image: ]


Figure 11:  Pressure Contours at t=0.019135 s
[image: ]


Figure 12:  Mach Number Contours at t=0.017993 s
[image: ]


Figure 13:  Mach Number Contours at t=0.019135 s
[image: ]

Tip
ANSYS Fluent gives you the option of exporting an animation as an MPEG file or as a series of files in any of the hardcopy formats available in the Save Picture dialog box (including TIFF and PostScript).
To save an MPEG file, select MPEG from the Write/Record Format drop-down list in the Playback dialog box and then click the Write button. The MPEG file will be saved in your working folder. You can view the MPEG movie using an MPEG player (for example, Windows Media Player or another MPEG movie player).
To save a series of TIFF, PostScript, or other hardcopy files, select Picture Frames in the Write/Record Format drop-down list in the Playback dialog box. Click the Picture Options... button to open the Save Picture dialog box and set the appropriate parameters for saving the hardcopy files. Click Apply in the Save Picture dialog box to save your modified settings. Click Save... to select a directory in which to save the files. In the Playback dialog box, click the Write button. ANSYS Fluent will replay the animation, saving each frame to a separate file in your working folder.
If you want to view the solution animation in a later ANSYS Fluent session, you can select Animation Frames as the Write/Record Format and click Write.
Warning
Because the solution animation was stored in memory, it will be lost if you exit
ANSYS Fluent without saving it in one of the formats described previously. Note
that only the animation-frame format can be read back into the Playback
 dialog

7. Read the case and data files for the 660th time step (noz_anim–1–00660.cas.gz and noz_anim–1–00660.dat.gz) into ANSYS Fluent.
8. Plot vectors at  s (Figure 14:Velocity Vectors at t=0.018849 s (p. 301)).
Results → Graphics → Vectors Edit...
a. Ensure Auto Scale is enabled under Options.
b. Enter 50 under Scale.
c. Enter 50 under Skip.
d. Click Display and close the Vectors dialog box.
[image: ]


Figure 14:
Velocity Vectors at t=0.018849 s
The transient flow prediction in 
Velocity Vectors at t=0.018849 s (p.
 seconds.


9. In a similar manner to steps 7. and 8., read the case and data files saved for other time steps of interest and display the vectors.





4. Summary
In this tutorial, you modeled the transient flow of air through a nozzle. In doing so, you learned how to:
· generate a steady-state solution as an initial condition for the transient case.
· set solution parameters for implicit time-stepping and apply a user-defined transient pressure profile at the outlet.
· use mesh adaption to refine the mesh in areas with high pressure gradients to better capture the shocks.
· automatically save solution information as the transient calculation proceeds.
· create and view solution animations of the transient flow.
5. Further Improvements
This tutorial guides you through the steps to generate a second-order solution. You may be able to increase the accuracy of the solution even further by using an appropriate higher-order discretization scheme and by adapting the mesh further. Mesh adaption can also ensure that the solution is independent of the mesh.
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